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LIMac has been
serving Macintosh
users on Long Island
since 1984, when the
Mac was introduced.
Annual dues for
membership is $24.
First meeting is free.
For information, you
can contact any of
the following:
Membership
Alan Gordon
(516) 538-7013
akgmac@villagenet.
com
Public Domain
Software
Helen and
Sheldon Gross
(212) 799-5655
SHEL1@ycybernex.net
Technical Advice
Bradley Dichter
(516) 874-4363
bdichter@cdr.net
Program
Coordinator
Rick Matteson
(516) 379-0174
RickGM@aol.com
Beginners SIG
Sy Bram
(516) 378-9076
SyBMFilm@aol.com
DTP SIG
Balan Nagraj
(516) 427-0952
Balan448@aol.com
ED SIG
Rick Matteson
(516) 379-0174
RickGM@aol.com
Internet SIG
Al Choy
AL0026@aol.com
Internet Address
http://www.limac.org

Towards a truly digital FORUM.
Do you use a Mac OS-based computer as a
hobby or as part of your business, your livelihood? If you use the Internet or an online
service for e-mail, you know the value of instant
news, communications and information. Do
you check your e-mail daily or even more
often? Your monthly user group FORUM is
packed with valuable tips and technical information. Wouldn’t you prefer to have the
FORUM, in a space-saving searchable Adobe
Acrobat file on your hard drive? You could have
the FORUM sent as an attachment to e-mail sent
to you each month. You don’t have to surf
around for it, it comes to you. As a competitive
edge, the e-mailed FORUM, comes to you days
before it shows up on the user group web site,
and a whole week before you would otherwise
get it in your snail-mailbox. You deserve to get
the information you need as soon as possible!
If you choose to have the FORUM e-mailed
to you, not only will you benefit, but so will
LIMac. If you choose to receive the FORUM
electronically, you will cease to get the it in

print. You can opt to resume if you find you
must read ink on paper. If we can reduce the
number of printed and mailed copies significantly, our recurring costs will be reduced. Your
dues will work harder for the betterment of the
services we can offer our members. Money
saved on FORUM costs can be redirected to
purchases we really need. We are very close to
being able to afford the new high quality
projector for which we’ve been hoping for
several months. If we contain our expenses a
little, it could be ours. You, the dedicated
LIMac member, can help all of us. I personally
urge you to send a brief e-mail to akgmac@villagenet.com (Alan Gordon) with the subject:
Please add me to FORUM e-mail list and your
real name in the body of the e-mail. You will
need Stuffit Expander and Adobe Acrobat
Reader to decode and open the attached
newsletter. Both are free and downloadable
from the LIMac web site, but as an advanced
Mac user, you no doubt already have them. l
–Bradley Dichter

June’s Meetings
General Meeting: Friday, June 13, 7:00 P.M.
Presentation on the Media 100 System by
PWR Systems: Media 100 is a digital video
editing system. The demo will also compare
this exciting product with Adobe’s Premier.
Ed SIG: Friday, June 13, 9:00 P.M.
The program is unavailable at press time.
Beginners SIG: Friday, June 20, 7:00 P.M.
The topic will be Word Processing.
DTP SIG: Friday, June 13, 9:00 P.M.
A demonstration of Extensis products.

Internet SIG: Monday, June 16, 7:30 P.M.
Further exploration of the Internet. The
Internet SIG will meet in the auditorium of the
Bethpage Public Library.
The library is located 3 blocks west of Exit 8 on the Seaford
Oyster Bay Expressway (Route 135). Parking is on the north
side (to your right) when approaching from 135. Turn right
as you enter the library to the auditorium.
LIMac Meetings, unless otherwise noted, are held at the New
York Institute of Technology (Building. 500), at Northern

Boulevard, Old Westbury. To see if school is open in bad
weather, call (516) 686-7789.

The next LIMac board meeting will be held at the Plainedge Library on Monday, June 16, 1997.

A few more FORUM e-mail details .
As a LIMac member, you can get the FORUM
e-mailed directly to you each month. You can
also send e-mail to Alan Gordon via the LIMac
Web Site (http://www.limac.org>FORUM Page).
The e-mail will be pre-addressed and the
subject will be filled in for you. Just include
your real name in the body of the e-mail. Alan

will check your name against his list of paid
members and forward the name to the ListServ
administrator, and then you’ll get the FORUM
automatically from then on. Please e-mail Alan
Gordon: change again if your e-mail address
changes. l
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VectorTools 2.0
By Mo Lebowitz,
Designer/Editor
Well, they’ve done it
again! Extensis just
released VectorTools
2.0 for Illustrator and
Freehand, and it’s a
winner. We’ve reviewed some of their other tools
(Intellihance for Photoshop, QX-Tools for
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President’s Remarks

Balan Nagraj
President
Balan448@aol.com

TIP!
Finding a Device’s
SCSI Address:
To see the SCSI
number of any
mounted SCSI
device, select its icon
on the Desktop and
select File>Get Info
(or type Command-I).
Its SCSI address is
shown in the Where
field of the Get Info
box.

TIP!
ClarisWorks 4.0:
Paint or draw.
When opening a
graphics file, make
sure you correctly set
the popup menu in
the Open file dialog.
If you want to use
painting tools to alter
individual dots on the
screen, set the
pop-up to Painting,
otherwise make it
Drawing.

Is Apple a software company or a hardware
company?
This question, often asked over the past few
years, is re-emerging as an important issue, in
light of recent announcements regarding their
licensing and hardware plans. Just as the Mac
clone makers start making headway, Apple has
thrown in a monkey wrench by raising the fees
charged to licensees.
Addressing this issue in his column in
MACWEEK of 5/5/97, Henry Knorr (Editor
Emeritus) suggests greater separation of Apple’s
hardware and OS businesses. Similar recommendations have been made concerning
Microsoft’s dominance in the OS & application
market. However, Apple does not have the
resources to pursue a strategy of being strong
in developing both innovative hardware and
operating systems. Just as I started writing this
column, news comes that Apple’s COO,
George Scalise has quit. He came on board
with Amelio and was promoted to be a COO
just last February. Given the losses suffered, the
resulting market perception regarding its
financial condition, the revolving door in the
executive ranks and staff cuts, can Apple really
pursue a dual-OS strategy and keep producing
innovative hardware? Both are required to stay
competitive with the Wintel platform.
The clone makers have contributed a great
deal in making the costs of Macs competitive
with the Wintel computers. Apple itself had to
change directions on their hardware plans a
number of times in the past few months. The
Exponential chip has been abandoned only a
month after a prototype was shown and the
Common Hardware Reference platform
(CHRP) is about to be abandoned.
The power to be the best was provided by
the revolutionary interface (GUI) and not the
hardware (gooey!). Is Apple inhibiting the long
term growth of the Mac OS by protecting their
hardware sales in the short run? Can they overcome the growing perception with both the
investment and developer community that
there seems to be no clear sense of direction.
To maintain a vibrant clone market – good for
the Mac OS in the long term – Apple has either
to separate the hardware side from the OS side,
or focus entirely on the OS. l

QuarkXPress) and found them to be musthaves. But VectorTools (from now on called VT)
is even more necessary.
There’s so much going on in this plug-in set,
that it’ll take a while to realize all the goodies it
brings to both Illustrator and Freehand. This is
the sequel to Extensis’ DrawTools, and if you use
them now, VT will place them on your Desktop
during installation for you to decide whether to
continue to use them.

For Illustrator users, VT looks like the other
Extensis Tools’ plug-ins, using customizable toolbars with visually identified buttons (text also, if
you desire) across the top of the Desktop that
take you right to the action by clicking. You can
choose from a complete list as well as create
your own actions with a SmartBar that watches
what you do, then makes a button.
VT includes these productivity tools:
| VectorTips: Over 200 Tips, Tricks and

Technical Corner
| How many Macs are allowed on an

AppleTalk network?
You can only have 10 Macs mounting a particular volume under System 7’s Personal File
Sharing, but the limit on the number of nodes
on an AppleTalk network is in the thousands.
You won’t have a problem with 14 Macs all
talking to one another and sharing a printer.
The only problem you would have is if they are
all connected with PhoneNet. The network
bandwidth is limited to begin with and then
divided by the number of devices trying to
communicate simultaneously, so things will get
really slow with 14 Macs on PhoneNet. It would
be much faster if you rewired for Ethernet, at
least for the more speed conscious workstations
which would support Ethernet better by having
NuBus or PDS slots, or even built-in Ethernet.
You can have a mixed network without
spending for each Mac. You do have to worry
about the end to end distance of your network
wiring, but most offices are fairly tight, so it’s
not usually a problem. If you need for more
than 10 Macs to simultaneously connect to a
shared volume, or for just better performance,
you would need to get a pre-configured Apple
File Server or add the AppleShare File Server
software to a Mac so it can handle the shared
volume. Apple’s latest is version 4.2.1 and
requires a PCI PowerMac. You might be able to
find the older AppleShare 4.0.2 for Quadra
series Macs, or even 3.0.1 for Mac II series. A
Mac running Personal File Sharing can only
spend 50% of it’s time in file sharing, so it’s
performance is modest at best. Use the shareware PowerShare 1.1 to increase the CPU time
allocation for those if you relying on Personal
File Sharing and can’t afford AppleShare File
Server (@$1000). Of course, you have the usual
problem of serial number copy protected software, checking for the same serial number on a
copy of a program running on another Mac on
the network.
| I’m having a problem in Netscape. I can
copy outgoing e-mail to a file and I can
browse around to specify where I want it to
go, but I can’t get it to stick. What can I do
about this?
I never tried before, maybe your Preferences file
is corrupted. I checked out the situation after
the meeting and my guess is you didn’t follow
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Brad Dichter
BradMacPro@aol.com

MEMBERS
We welcome the
following members
who have joined
LIMac in the past
month:
Robert Levy
Gary Nolan
Carl and Collette
Wampole
May Raffle Prizes:
Pagemaker 6.5
by Adobe
Morton Blum
Bricks by Gryphon
Victor Susman
Fax STF by STF
Technologies
Sy Bram
Apple CD
Gary Nolan
Tektronics Ink
Victor Susman

Techniques from two experts in Postscript
software: Ted Anspach, and Olav Martin Kvern.
| VectorColor: Edits colors and curves in
grayscale and color modes; adds color to black
& white art; makes color art into duo, tri and
quadtones; and controls sharpness of art with
brightness/contrast adjustments.
| VectorMagicWand: selects path by attributes
much like Photoshop’s Magic Wand.
| VectorNavigator: shows the entire document

so you can quickly and accurately move to any
location. A great help when working in super
enlarged areas.
| VectorFrame: adds frames to individual,
grouped and groups of objects.
| VectorShape: 2-dimensional illustrations
become 3-dimensional with sphere, cylinder,
cone, diamond, water, waves and free projection, by twisting and distorting bezier and spline
anchor points to get the effect you want.

| VectorObjectStyles (Illustrator only): to

quickly apply predefined styles to items.
| VectorTypeStyles (Freehand only): controls
typography all the way down to character level.
| VectorLibrary: store images for later use.
I picked up on most of them simply by
sticking to the Mac Way. But when you buy VT,
you get a super manual (plus a PDF versions)
that is clear and concise with complete explanations of everything, and I mean everything.

You’ll even read about who worked on the VT
team, and what types, etc., were used in the
manual. And their tech help is good. I’ve tried
them. Try VectorTools – you’ll like them. l
VectorTools 2.0
Extensis Corporation
Order at 1-800-796-9798, www.extensis.com,
or major software resellers.
$99.95 (Upgrade from DrawTools is $49.95)
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More Technical Corner

TIP!
Page tricks in Adobe
Acrobat Exchange:
| Since most document-creation
programs can’t
support multiple
orientations in one
document it’s easy to
forget that PDF files
do. You can combine
pages from any
number of documents (in any
number of orientations) within one
PDF; and the pages
will retain their
various sizes. If you’re
coming from
PageMaker, you can
even put spreads in
your PDF – a good
way is to check the
Reader’s Spread
option in
PageMaker’s Print
Document dialog
box.
| To combine pages
of many shapes and
sizes within one PDF,
use the Insert
Pages… or Replace
Pages… command
from the Edit menu in
Exchange while you’re
in the destination
file, and select a file
from which to take
new pages. (Inserting
will import all the
pages in a file, but
you can select a
range of pages when
you use Replace.) You
can also open the
source and destination files and drag
thumbnails of pages
from one to the
other.

the right procedure. In the Mail & News
Preferences dialog box Composition tab, you see
the choice there. What you probably want to
do first is to bring up the Netscape Mail
window and from the File menu, select New
Folder and name it something appropriate, like
Sent Mail. Then, what you want to do,
assuming you want this to be stored somewhere else, is open the Hard Drive, open the
System folder, the Preferences folder, the
Netscape ƒ folder and finally, the Mail folder. In
there you will find Sent Mail and Sent
Mail.snm. Move these two files to a folder in
the location you prefer. Now close up all those
windows and go back into Navigator. Go to
the Options>Mail and News Preferences>
Composition>tab. Click on the checkbox before
Mail File and then hit the Browse button. Then
navigate or browse to the folder you created
that contains the Sent Mail and Sent Mail.snm
files. Double-click on the Sent Mail file and
click OK in the Mail and News Preferences
window. Quit out of Navigator, start it up
again and check the setting. It should be OK
now. Note the option is to save the outgoing
messages to a file, not a folder, so you had to
create the right kind of file and then move it to
where you want it. By the way, use MIME
Compliant in your mail settings in that same
dialog box.
| I’m using FreePPP 2.5v2 & a Global
Village TelePort Platinum modem. I’m
using a setting regarding init string to rely
on the TelePort Control Panel. What setting
in the TelePort Control Panel should I use
for compression?
Use V42.bis, it offers the best compression. I
would suggest the AutoDetect init string function myself. Also update to FreePPPv2.5v3 and
PPP Menu 2.0.3.
| TelePort Platinum 28.8 is on sale for $79,
but the ad says it needs PowerMac or
GeoPort serial port Mac. I have a Performa
631CD.
The Platinum uses the ninth pin featured on
the GeoPort. If you have a non-GeoPort
equipped Mac, then the connector won’t fit.
You can use other brands of 28.8 MODEMs,
like US Robotics, because they use the standard
8 pin (Mini DIN 8) serial connector. The
Performa 63x series do not use GeoPorts. But

not all PowerPC based models have GeoPorts.
The Performa 52xx/53xx/62xx models don’t
have GeoPorts, either. The 54xx/6360/64xx
models do, however. PowerBooks don’t use
GeoPorts either, not even the new 3400. You
could go for a new, but pricier, US Robotics
Sportster 56K X2 modem ($220) and switch to
an Internet service provider that uses them, like
I-2000 and Hamptons Online. AOL is in trials
in NYC for the X2 and will be later trying the
competitive and incompatible K56Flex from
Rockwell. If you have a good NYNEX phone
line, and regularly connect at top speed, then
you stand a good chance of getting the most
out of a 56K modem.
| Will a laser printer print crisper than any
ink-jet printer? Even the Personal LaserWriter 300? I saw the ad for the Okidata
OL610e for $400, a 600 dpi PostScript
printer that uses LEDs instead of a laser.
Yes. The LED-based printer will print just as
well as a laser-based printer at 600 dpi.
| If you print to an PostScript laser printer,
do you have to use an AppleTalk connector?
What if I use a switch box to switch to an
inkjet printer like the Apple StyleWriter
2400?
Apple calls their connectors LocalTalk, not
AppleTalk. AppleTalk is a network protocol.
Most people use PhoneNet or equivalent connections nowadays. It is not recommended
with newer Macs, but you could use a straight
serial connection. You can still use an A/B box
but you would have to make AppleTalk active
for the laser printer and inactive for the
StyleWriter, as well as throw the switch and
make a selection in the Chooser. You could get
an AppleTalk adapter for the SW2400 ($100)
and use a PhoneNet connector instead of the
A/B box and leave AppleTalk active. A set of 3
PhoneNets would be $48. If you are not running OpenTransport, the transition from
inactive to active would require a restart.
| Rather than use the PostScript printer
driver from the manufacturer, can I use the
Apple LaserWriter driver?
Apple’s latest driver is preferred to older version
from third parties. The last version of the
LaserWriter Driver was 7.2; the latest version of
LaserWriter 8 for 68K Macs is 8.3.4. The latest
and greatest is 8.4.2. l
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TIP!
Some interesting
applications found
by the Editor while
rummaging around
AOL’s software
search lists:
SplitIt!:
Breaks down files
and applications into
parts that will fit on
floppies, and can
later be re-assembled for use.
FeatherGIF:
A Photoshop Plug-in
for use on GIF files
meant for the Web. It
adds feathered edges
to your images.
India Ink:
Another Photoshop
Plug-in. This one
converts images to
cross-hatched lines.
Dos2Mac:
Converts text from
Dos to Mac format
with no PC junk.
Drop2Register:
Keep all of your
applications’
serial/registration
numbers at your
fingertips.
AutoMenus Pro:
This one came from
the Web, but it’s
worth mentioning
here. A great Control
Panel for holding
open pull-down
menus and allowing
you to travel through
sub-menus without
strain on your wrist;
just holding your
cursor over a menu
opens it, and all you
do is go to the item
and click on it. It
allows more control
and accuracy when

Long Island Macintosh Users Group
Post Office Box 518
Seaford, New York 11783

Don’t miss the presentation
on the Media 100 System by
PWR Systems: Media 100 is a
digital video editing system.
The demo will also compare
this exciting product with
Adobe’s Premier.
Friday, June 13, 1997, 7P.M.
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Helen and
Sheldon Gross
SHEL1@cybernex.net

TIP!
Layer Moving in
Photoshop 4.0:
In Photoshop.4, the
layering shortcuts
have been reassigned.
Command-]: Move
selected layer to the
top.
Command-[: Move
the selected layer to
the bottom.
Command-Shift-]:
Nudge the layer up
one layer.
Command-Shift-[:
Nudge the layer down
one layer.
You can’t move the
Background layer
until you rename it.

Sore Eyes

User Group Connection

We know most netters are familiar with
HOTWIRED, the online line newsletter devoted
exclusively to all things and people related to
computers. The URL is http://www.hotwired.
com/frontdoor/. It is truly an all-encompassing
publication, sometimes esoteric, sometimes
very newsworthy and sometimes funny.
On the lighter side and to keep our members up to date on the latest terminology, The
following are definitions excerpted from WIRED
magazine’s Jargon Watch department:
Astroturf. A fake grass-roots political campaign. Posted in RISKS DIGEST as a potential
future problem in net-based issue campaigning
where massive phony mailings are easier than
ever.
Betamaxed. When a technology is overtaken
by an inferior, but better-marketed technology.
Microsoft betamaxed Apple out of the market.
Binary Star Configuration (or Bi Star).
Any grouping of two things that are apparently
inseparable, for whatever reason. Bike messengers and tattoos: totally bi star! Brad and Apple,
supremely bi-star.
Bit-spit. Any form of digital correspondence
(text, bit-mapped images, fax transmissions) or
the act of sending same. Did you bit-spit that
file to Jane yet ?
BLOB. (Binary Large OBject) Used to describe
very large binary files. The speed of your server is
a function of the size and number of BLOBs
you’ll be moving through the network.
Cybrarian. One who makes a living doing
online research and information retrieval. Also
known as a data surfer or a super searcher.
Infobahn. Term being bandied about on
Capitol Hill as a faster and more globalsounding replacement for the more cumbersome Information Superhighway. l

In the September 1996 issue of the FORUM,
I reported on a study done by the UGC, in
conjunction with Para Technologies, designed
to gather information about both Mac/Apple
computer user groups and PC/Windows/
DOS-based computeruser groups.
In this issue I would like to share some
results of a follow-up study. The information
below was supplied by the UGC.
User group members shown to be
purchase influencers, heavy Internet users –
Soquel, California; June 25, 1996: Approximately 70% of PC and Macintosh user group
(MUG) members access the Internet, and 77%
of members without access plan to be on the
Internet within a year – according to a new
study of U.S. Macintosh and PC user groups
from User Group Connection (UGC) and Para
technologies. In addition, 78% of members
claim to influence an average of $45,000 worth
of work-related computer purchases per year.
The disk-based survey, which sampled
Macintosh and PC user groups in the U.S., also
revealed that PC and Macintosh user group
members differ from each other in demographics, influence, and computer usage. In
comparison, Macintosh user group members
earn a higher (mean) household income
($66,239 Mac vs. $59,725 PC), and more
MUG members have a college degree than PC
user group members (77.9% Mac vs. 52.5%
PC). However, more PC members are Chairperson, President, or Owner of their company
(17% Mac vs. 33% PC).Despite these differences, the study supports similar findings from
1990 and 1992 studies, concluding most user
group members are well-educated, affluent, and
influential computer enthusiasts. l
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Max Rechtman
MaxLIMac@aol.com

FOR
SALE:
Quadra 700Mini-Tower:
MacOS 7.55.
540 Meg HD/20
Megs RAM/2 Megs
V-RAM.
Supports 24-bit
color on monitors
up to 17 inches.
Built-in Ethernet.
Looking for a fair
price.
Also an Imagewriter II
–Bill Medlow
ArchBill@aol.com

